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Abstract 

In the 17th century, Robert Hooke was known as the scientist who first discovered cells through 

microscopy. From that point on, it has sparked the curiosity of many scientists leading to 

numerous experimental studies, the onset of discoveries, scientific theories, and drug 

development. Even then after understanding the function(s) of different cells, scientists knew that 

the roles of cells in eukaryotic organisms were limitless. Cells allow us to perform work, and 

each type has its own distinct role(s). They have an inner framework known as the cytoskeleton 

which is composed, in part, by microfilaments made of actin proteins and microtubules made of 

tubulin proteins. We used a freshwater invertebrate model, Daphnia magna, to learn more about 

the cytoskeleton. D. magna have a long record of being used for various ecotoxicological, 

genetic, and evolutionary studies. In previous works, the cytoskeleton was discovered in its 

carapace epithelium. Since then, researchers have been investigating the proteins that reside there 

as a way to define the importance of their functions in eukaryotic cells. Cytochalasin D (CD) and 

Nocodazole (Noc) are two drugs that have been shown to disrupt the structure of actin 

microfilaments and microtubules, respectively. This study quantitatively assesses the effects of 

those two drugs on the microfilaments and microtubules in D. magna using the NIS-Elements 

BR software for two main reasons: to support past findings from prior experiments done by 

experts, and to help us draw inferences as to how these proteins would behave after being 

exposed to drugs like Cytochalasin D and Nocodazole. Our results suggested that the protein 

microfilaments were sensitive to the drug Cytochalasin D. Likewise, it suggests a positive 

correlation between nuclei and F-actin and implied that the molting stage influenced the area of 

F-actin and nuclei. 

Keywords: Cytochalasin D, Daphnia magna (D. magna), in vitro, molting stage, cytoskeleton 
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Introduction 

Daphnia magna are small (1.5-5.0 mm) freshwater invertebrates belonging to the Daphniidae 

family which closely resembles the anatomy and physiology of a shrimp (Elenbaas, 2013). They 

have a “carapace integument consisting of two cuticle-secreting epithelial layers, one deep 

(proximal) and one superficial (distal) layer which is separated by a hemolymphatic chamber and 

joined together by pillar structures” (Christensen, Owusu, & Jean-Louis, 2017). Often times, 

they are called “water fleas”, suspension-feeders or freshwater invertebrates which all are used 

interchangeably (Bethesda, 2005). Expect to find these small water crustaceans amongst the 

rockiest regions of water currents. For the most part, they are found in places that are not too 

high or low in salinity levels because their bodies can only tolerate about 4-8 ppt of salt (Centers 

for Freshwater Biology, 2013).  

 Under optimal conditions, these organisms reproduce diploid eggs (eggs containing 20 

chromosomes) asexually through the process known as parthenogenesis (Stollewerk, 2010). 

During this process, the eggs are kept in the brood chamber for approximately three days before 

they are released as clones. That is to say, the neonates resemble their mother both physically 

and genetically (Stollewerk, 2010). It makes sense to assume that D. magna are all females, 

however, that is not always the case. When they are “triggered by external stimuli… Daphnia 

produces haploid resting eggs (eggs containing 10 chromosomes) … requiring fertilization and a 

period of extended dormancy in order to develop” (Stollewerk, 2010). Hence, the environment 

directly impacts whether the adult will reproduce female clones or a heterogeneous mixture of 

male and female neonates. The differences result from extreme conditions such as a confined/ 

over-populated area, insufficient nutrient, water with temperatures falling below or above the 

ideal temperature all which can increase their stress level. Just like humans, D. magna bodies 
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will respond to stress by releasing hormones and accounting for the sex differences seen in 

neonates (Clare, 2002). Other things that occur as well when stress hormones are triggered by 

external stimuli include an increase in their heart and breathing rates.  

 

Molting Stage 

Daphnia magna can go through a series of molting phases as they become adults and reproduce. 

Ecdysis is a term used for “molting” (H.H. Hobbs, 2010). It is the necessary process of 

discontinuous cuticle transformations which is important for growth and development as 

mentioned in Ecology and Classification of North American Freshwater Invertebrate. Humans 

molt too. It is seen by the continuous shedding of hair follicles, nails as they break or are filed 

down, and continuous loss and renewal of skin (Juan, 2006). Cladocerans molt by replacing their 

external exoskeleton (superficial layer) with the exoskeleton formed in the deep layer to grow 

(Dodson & Rogers, 2010). Likewise, after the female releases her neonates, absorbs nutrients, 

and regains her strength, she sheds replacing the superficial layer with the deep layer. The 

number of times Cladoceran molts varies depending on the kind of Daphnia, its sex, and age. For 

example, “Chydorid neonates may molt just twice, but larger daphnids may molt as many as 

seven times before becoming adults (Dodson & Rogers, 2010). For that reason, there is a positive 

correlation between the molting periods and the volume or size of Cladocerans. When these 

organisms molt, usually “their volume doubles and length increases” (Dodson & Rogers, 2010). 

For that reason, the molting periods will most likely be responsive to environmental stressors. 

Therefore, it is critically important that ideal conditions are met to allow growth, development, 

and clonal reproduction for both in vitro and in vivo research studies.  
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Cytoskeletal Components and Inhibiting Agents  

Before sharing the results of this study, it is important to understand the functions of the three 

structures we examined. First, microfilaments are long polymers of the protein F-actin, which is 

one of the most conserved, and abundant eukaryotic protein. Actin is involved in cellular 

processes such as allowing cell motility, muscle contraction, has some nuclear roles and “is 

encoded by different members of the actin gene” (Cooper, 2000). The protein actin does not 

function alone; instead, it engages in protein-to-protein interaction to reveal its dynamic 

functions (Cooper J. A., 1987). Microfilaments can concentration in bundles, which have a polar 

positive end and polar negative end to allow assembly/disassembly of actin monomers (Cooper, 

2000). Both of these processes occur simultaneously; however, the addition of actin monomers is 

much faster at the positive end creating what is known as the treadmilling effect (Cooper, 2000). 

When exposed to Cytochalasin D, the drug attaches to the ends of the bundles and prevents 

additional attachment of actin monomers (Cooper J. A., 1987).  

Nocodazole acts in this same way when it is exposed to microtubules, hollow tubes that 

are composed of tubulin subunits helping keep the cytoskeleton organized and maintaining its 

shape. They make up the flagella which are found at the tails of sperms, cilia which are found 

along the linings of our windpipes (trachea) and form the mitotic spindle which is crucial for cell 

division (Davidson, 2015). 

Lastly, we examined nuclei, organelles found freely in the cytoplasm of eukaryotic cells 

only. It aids with protein synthesis, the cell cycle, and stores hereditary information known as 

DNA which tightly bundles up to form a chromosome. Essentially, chromosomes are DNA 

containing thousands of genes that encode information like our traits and characteristics 

(ESYOH, LLC, 2019).  
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NIS-Elements Basic Research Software 

This “microscopic imaging software is geared for acquisition and device control for standard 

research applications requiring four-dimensional imaging” (Nikon Instruments Inc., 2019). In 

other words, it is software that allows the usage of tools and applications installed in the program 

to analyze images captured by high definition and resolution microscopes like fluorescent 

microscopes. As seen in the NIS-Elements Basic Research (BR) User’s Guide, this software has 

various functions allowing researchers to select regions of interest (ROIs), decrease background 

noise, modify the intensity, alter magnification, adjust binary threshold and many more to help 

with basic or complex analysis of 3D images.  

 

Statement of the Problem 

Actin is the driving force for cell motility, muscle contraction, and joins together to form 

microfilaments. Microfilaments polymerize and depolymerize as actin monomers attach to its 

barbed end. Previous works performed by researchers, and experiments replicated on this 

campus have suggested that F-actin polymerization and depolymerization is disrupted by 

Cytochalasin D. Without a doubt, that has to mean that if these processes stop, then something 

must be happening to the cell(s) function overall. One of the issues researchers found is that “F-

actin seem to trigger cell death through an apoptosis-like pathway” (Levee, Dabrowska, Lelli, & 

Hinshaw, 1997). A year later, Disruption of actin filaments by CD leads to activation of p53 was 

published. P53 is a tumor-suppressing and mediating protein for apoptosis that is activated when 

DNA is damaged (ThermoFisher Scientific, 2018). Although activation of p53 is good, if CD 

inhibits F-actin polymerization, F-actin disruption can alter and affect cellular processes along 

the cell cycle. That has to mean that apoptosis (programmed cell death) will result for nearly all 
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cells. That is a problem. Actin is found in all eukaryotic cells. This type of expression is called 

“ubiquitous”. Although researchers defined the functions of actin and found that it is located in 

various parts of the body such as the brain, spine, smooth muscles, etc., there are still questions 

they are seeking to answer.  

 

Purpose 

The goal of this study was to investigate whether microfilaments, microtubules, and nuclei are 

truly affected by inhibiting agents like Cytochalasin D and Nocodazole by comparing their size 

quantitatively both before and after the drug exposure. Secondly, our goal was to see whether the 

molting stage is contributing to the dismantling of F-actin bundles to further make inferences as 

to how it may play a role in the molting cycle. By examining these effects of molting stage and 

drug exposures on the cytoskeleton will allow us to think about the sensitivity of these same 

proteins in human cells.  

 

Hypothesis 

1. The area of filamentous actin will be higher when it is exposed to Cytochalasin D 

compared to controls. The area of tubulin will be similar in cells exposed to Nocodazole 

and controls. Nuclei will not be affected by either drug exposures. 

2. Actin will predominantly be found in the superficial layer of the exoskeleton; while, rich 

amounts of tubulin will be kept in the deep layer. There will be no difference in the 

number of nuclei present between the superficial and deep layers.   
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Questions 

1. Does Cytochalasin D affect the size of F-actin or does disruption result from molting 

stage?  

2. Does Nocodazole affect the size of tubulin? 

3. Which exoskeleton layer contains filamentous actin, tubulin, or nuclei the most? What 

would this imply?  

4. Could both drugs affect the size of the same component? 

5. Will nuclei resist change after drug exposure? 

 

Relevance to Field of Health Sciences 

As a future healthcare professional, this kind of research is very important. It allows us to 

understand the overall functions of specific proteins within our cells. Also, it investigates how 

drugs can affect our proteins and allows us to draw connections as to how those defects in those 

proteins can lead to health complications that humans and animals experience. As mentioned 

above, actin, tubulin, and nuclei reorganize in both in vivo and in vitro cells and play a huge role 

in eukaryotic cells. If Cytochalasin D causes the depolymerization of F-actin than, that means 

that actin, the driving force for cell motility and its contractile abilities will be hindered as well. 

Hippocampal seizures cause depolymerization of filamentous actin in neurons independent of 

acute morphological changes is an accessible article published back in 2008. This study 

confirmed that microfilament depolymerization can lead to neurological disorders like 

Alzheimer’s disease or epilepsy and vice-versa (seizures can impact filamentous actin). In fact, 

the consequences that can result from a change in the morphology of cytoskeleton components 

like microfilaments include fibromyalgia, actin-accumulation myopathy, and muscular 
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dystrophy. Although these conditions may not be directly caused by F-actin or actin alone, each 

one of these conditions can easily be linked back to this protein in the cytoskeleton. Therefore, 

this study is important in medicine and to the science field because filamentous actin proteins are 

ubiquitous in eukaryotic organisms.  

 

Definition  

If you are interested in working with Daphnia magna, it will be helpful to recognize and know 

the common terms that are used when working in the lab. As you know, there are no limitations 

to medical terminology or scientific vocabulary. For that reason, only a few terms mentioned in 

this study will be defined. 

Daphnia magna (D. magna) - Aquatic organisms  

Carapace epithelium- Transparent shell that makes up the tissue of D. magna 

Water fleas- Name was given to D. magna because of its vertical jump-like motion 

Suspension feeders- Consumers of small debris such as bacteria, algae, and yeast 

Freshwater invertebrates- Aquatic organisms lacking a backbone 

in vitro- (Latin, adverb) Describes an experiment performed on tissues of non-living organisms 

in vivo- (Latin, adverb) Describes an experiment performed on live organisms 

Cytochalasin D (CD)- Filamentous actin polymerization inhibitor  

Nocodazole (Noc)- Microtubule polymerization inhibitor 

DAPI (4′,6-diamidino-2-phenylindole)- Fluorescent dye used to adhere to AT regions in DNA 

Fluorescent microscope- Allows us to view, highlight structures, and capture images of tissues 

Stereoscopic microscope- Allows us to surgically extract tissues or contents from an organism 

  



Running head: CYTOCHALASIN D EXPOSURE AND MOLTING STAGE  10 

Time Restrictions 

The quantitative analysis of D. manga took quite some time. The actual drug exposure was done 

during the summer by Dr. Arne K. Christensen, while the analysis of the images was completed 

during the fall semester. If this experiment is performed from scratch, literature works will help 

determine the drug concentration (dose), the exposure time, chemicals and reagents used for 

methodology, fluorescent dyes, and microscale equipment required to run the experiment. 

Gathering this information alone can take a few days and up to a month as it is the foundation of 

creating an experimental design. Expect to spend roughly one to two months doing culture care 

and performing the actual experiment, yet another month or two (depending on the number of 

tissues that are being examined) to use the NIS-Elements BR software and Microsoft Excel to 

create the necessary tables and figures. Lastly, it will take roughly two months to draw 

conclusions from those charts and diagrams especially if you do not have much experience 

interpreting figures. It did take time to find a method that would reduce background noise 

without changing the intensity of the signals we were interested in examining. But overall, this 

study is pretty flexible if it is done as an independent study.  

 

Ethical Consideration 

For the most part, Daphnia magna are commonly used in research today because they are fairly 

small inexpensive invertebrates that do not pose many moral concerns to the general public 

compared to a rat, dog or human being. Anna Maria College policy states that “any principal 

researcher who is proposing to conduct a study with human subjects… must complete all parts to 

seek approval from the College’s Institutional Review Board (IRB)”.  Therefore, there was no 

need to complete IRB forms. If this study worked with mice and focused on “finding the link 
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between a particular gene and human disease”, check with the institutions policy about these 

vertebrates before beginning the study (NIGMS, 2019). Usually, if an organism contains a 

backbone and is larger in size, the process to have them approved will be long. Under most 

circumstances, it will be rejected if the purpose of using it is not reasonable. Some reasons as to 

why D. magna works best for in vivo studies like this one is because these aquatic organisms are 

much easier to manipulate and examine compared to larger species. Another reason is that it 

allows us to examine its tissues using microscale equipment’s, are reliable, have fast 

reproduction rates and has our genes of interest (i.e. actin and tubulin) closely resembling that of 

humans. 

 

Literature Review 

In order to conduct a research study, it is necessary to search and see if there are prior publishing 

works that relate to the study itself. By doing so, it will allow the researcher(s) to 

compare/support their findings, validate their experimental design and minimize error. In 1987, 

the Effects of Cytochalasin D and Phalloidin on actin was published confirming that 

Cytochalasin D inhibited microfilament polymerization and induced depolymerization. Inducing 

depolymerization means that the rates of disassembly increases when the protein is exposed to 

Cytochalasin D. After reviewing their method and results, we conducted a short- and long-term 

experiment to test the effects that 2 g/mL of CD would have on the carapace epithelium of D. 

magna. This experiment was performed earlier with other students and supervised by Dr. 

Christensen. The information we obtained from this study was useful because it sparked other 

questions and hypotheses. For instance, following that experiment, we conducted a study testing 

the effects of 50 g/mL and 100 g/mL of Nocodazole on tubulin for 2.0 hours. This study 
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suggested that the protein was resistant to Nocodazole despite the increase in drug concentration 

which implied that molting stage could potentially be a factor in its resistance. For that reason, 

we reviewed the information given in Patterns of DNA Synthesis and Mitotic Activity during the 

Intermolt of Daphnia, a study that investigated the relationship and effects of cell division rates 

and molting periods of D. magna.  

The same effort goes into data analysis as well. Prior works serve as resources especially 

when images are not clear to interpret or identify. In search of a method to minimize the blur, 

also known as background noise, the subtraction method was applied. Without the subtraction 

method, the ability to select regions of interests would become a challenge. This tool was used in 

a previous study, A Practical Approach to Quantitative Processing and Analysis of Small 

Biological Structures by Fluorescent Imaging, in which they found its application in NIS-

Elements software useful to remove the background noise without affecting the intensity of the 

objects. 

 

Methods 

Since this study focuses on quantitatively analyzing the cytoskeletal structures of D. magna, the 

culture and physical requirements, isolation techniques, and drug exposure needed to conduct the 

experiment will not be described in depth. Though, this section will cover the methods and 

materials that were used to analyze our findings in greater detail.  

 

Culture and Physical Requirements 

Prior to this semester study, Daphnia magna were kept under their preferred living conditions. 

Conditions were similar to previous works consisting a photoperiod of 16:8, placement into a 
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250 mL glass beaker containing COMBO media with Ankistrodesmus, an algal culture in a water 

bath at about 20- 21°C (Kilham, Kreeger, Lynn, Goulden, & Herrera, 1998). Daphnia magna 

were monitored over a few weeks for optimum growth and development. Adult females were 

extracted from the COMO media once they reproduced neonates. The neonates were then 

carefully monitored for optimum growth and development.  

 

Isolation of Mature Daphnia  

Once the neonates grew into adult females, they were transferred into a new container and placed 

into an ice bath to reduce their heart rates. Dissection of these of D. magna was performed on a 

petri dish and under a stereoscopic microscope.  

 

Drug Exposure 

After the tissues were isolated from the model organism, it was exposed to 0 g/mL and 2 

g/mL CD in DMSO, 50 g/mL, or 100 g/mL. For both experiments, the tissues were rinsed 

with a broad-spectrum of antibiotics, rinsed with Phosphate Buffered Saline (PBS), fixed in PBS 

4% PFA, stained with Phalloidin solution and DAPI to prepare the tissue for fluorescent 

microscopy.  

 

Nikon: NIS-Elements Basic Research Software and Data 

After capturing images via florescent microscopy, using the NIS-Elements BR software, the 

objective calibration was set to 40X. Thereon after, the subtraction method was applied to 

remove background noise. Once the subtraction method was applied, white signals appeared on 

the screen of the software after choosing an image from a file. The regions of interest (ROI) that 
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did not contain artifacts and was clearly distinct from other structures were selected for each 

image from the “DrugstoMeasure” and Post/Pre-Molting files. The binary threshold altered 

between the different files yet remained fixed within the images of one file. To prevent error in 

data, or obscured results, artifacts was not considered in the data collection. In other words, if the 

objects significantly fell outside the object border, they were not selected as an ROI. Upon 

deletion of the objects that were outliers (too large/small in size, oddly shaped, extremely faint, 

etc.), the measurements were collected, transported to Microsoft Excel, saved and then used to 

create tables and figures for analysis. Below are the steps used to analyze the images in greater 

detail.  

 

Step 1: Change the Objective Calibration   

Click View> Acquisition Controls> Manual Microscope Pad > Click 40X objective 

  

Step 2: Applying Subtraction Method 

Select ROI> Simple ROI Editor> use Polygon tool> select an empty “dark” region and double 

click> save ROI in file> Open an image > Click ROI> load ROI> search for saved ROI> use as 

background> Click Image> Background> Subtract Background using background ROI 

  

Step 3: Selecting Regions of Interest 

Click ROI> Simple ROI editor> polygon > click around objects and double click when 

complete> delete by right-clicking or selecting “Delete Selected ROIs”> select “Finish” 

  

Step 4: Defining Binary Threshold 

Click Binary> Define Threshold> Adjust to fit images of the same file and set “High” at 

16,000> Press Enter> Click “Ok” (objects should appear red) 

  

Step 5: Collecting Measurements 

Click View> Analysis Controls> Automated Measurements Results> Select “Current”> if there 

is already data, clear it by hitting the button with the red “X”> Click the red circular arrow 

“Update measurement”> Click Export> Save Excel file 

  

Step 6: Creating Data Tables using Microsoft Excel 

Label rows (sample, objects area, objects area *38.38, sum intensity. Copy and paste “Objects 

Area” and the “Sum intensity” from the excel to the new excel file with the labels. Once 

complete, find the average and standard deviation. Make sure to separate control group data 

from drug exposure data and post from pre-molting data. 
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Step 7: Generating to Plot Diagrams via Microsoft Excel 

Label rows (structure, SD) and columns (CD, Noc, Noc+CD, Control, Post (Super/Deep), or Pre 

(Super/Deep)> Highlight data to create table > to choose a table click “insert” tab> Choose 

appropriate chart/diagram (i.e. clustered column)> to edit table go to “chart design”> to add 

error bars select “Add chart element”> click “error bars”> select “standard deviation”> 

double click bar> click “no cap”> set direction to “plus”> and affix the error amount by 

adjusting value. To adjust value: select “custom, specific value”> highlight the numbers and 

press enter. Continue to edit as necessary. 

 

Results    

Binary Thresholds 

Below are the binary thresholds that were set for the drug exposure files and the post/pre 

molting file.  

Cyto_DAPI                                      920-16000 

NocCD_DAPI                                 880-16000 

Post_Pre_Molt_DAPI                      924-16000 

  

CytoD_actin                                     1600-16000 

NocCD_actin                                   1960-16000 

Post_Pre_Molt_actin                       4029-16000 

  

CytoD_tub                                       1321-16000 

NocCD_tub                                      1500-16000 

Post_Pre_Molt_tub                          2000-16000 

 

DAPI 

As seen in Figure 1, the area of the organelle in the control group from the CytoD_DAPI file was 

22.78 m2 (= 2.67 m2). In the tissue exposed to CD, the area of the nuclei increased by 17.41 

m2 (= 4.3 m2). The control group for the NocCD_DAPI file had a nuclei area of 32.41m2 

(= 6.41 m2). When DAPI was exposed to Nocodazole the area of the nucleus was 39.17 m2  

(= 9.95 m2). However, when DAPI was exposed to both Nocodazole and Cytochalasin D 

drugs, the area of the nuclei was 35.19 m2 (= 5.16 m2). After comparing nuclei exposed to 

just Nocodazole to nuclei exposed to just Cytochalasin D there was a difference of 1.02 m2. As 

indicated in Figure 4, the area of this organelle in the post-molting period, located in the deeper 

layer was 25.03 m2  (= 1.92 m2 ), while in the superficial layer of the post molting period had 
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a nuclear area of 32.56 m2  (= 2.35 m2 ). The deep exoskeleton layer of D. magna had a pre 

molting period area of 33.11m2 with a standard deviation of 10.96 m2. The pre-molting period 

area of this organism in the superficial layer was slightly lower than the deep layer of the pre 

molting period with a difference of 1.93 m2 (= 3.18 m2). By solely looking at the margin of 

error (standard deviation), the deep exoskeleton layer of the pre-molt period has a larger margin 

of error. This is suggesting that there were probably more nuclei found there.  

 

Filamentous actin 

As indicated in Figure 2, the area of this cytoskeletal component in the control group from the 

CytoD_actin file was 110.39 m2 (= 37.54 m2). Once F-actin was exposed to CD, the area 

increased to 190.70 m2 (= 67.12 m2). That is a total increase of 80.31 m2 between the 

control group and CD exposure of the same file. The area of the control group from the 

NocCD_DAPI file was 310.18 m2 (= 270.51 m2); while the area of just Noc exposure was 

386.93 m2 (= 30.06 m2). After being exposed to both drugs the area was 224.18 m2 (= 

84.5 m2). The error bars are large in control group 2, thus Noc or Noc+CD treatments may not 

have an effect on F-actin structure. Therefore, these values are insignificant. As indicated in 

Figure 5, the deep exoskeleton layer of D. magna post-molt area of 227.42 m2 (=39.53 m2). 

On the other hand, the superficial layer post molt had an area of 139.57 m2 (= 69.88 m2). In 

the deep exoskeleton layer pre molt, the area was 227.2 m2 with a standard deviation of 145.77 

m2. On the contrary, the pre-molt area of this organism in the superficial layer was slightly 

lower than the deep layer with a difference of 2 m2 with a standard deviation of 50.20 m2. By 

solely looking at the error bars, the deep exoskeleton layer of the pre-molt period suggests that 

there are more F-actin structures located there.    
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Microtubules 

In the study between the microtubules (tubulin) and the various drug exposures as indicated in 

Figure 3, the area of this component in the control group from the CytoD_actin file was 108.94 

m2  (= 115.42 m2). When tubulin was exposed to Cytochalasin D drug the area was 126.76 

m2 (= 82.23 m2). That is an increase of 17.82 m2. The area of this component in the control 

group from NocCD_DAPI was 136.15 m2 (= 131.81 m2), but when tubulin was exposed to 

just Noc the area was 186.99 m2 (= 39.03 m2). When tubulin was exposed to the combination 

of both drugs, the area was 107.04 m2  (= 36.92 m2). There was a difference of 60.23 m2 

between the independent exposures of CD and Noc. As seen in Figure 6, the deep exoskeleton 

layer of D. magna had a pre-molting area of 48.33 m2 with a standard deviation of 44.76 m2 . 

Whereas, the area of the superior exoskeleton layer of the pre-molt is 67.94 m2 (= 58.88 m2). 

The pre-molting period area of this organism in the superficial layer was higher than the deep 

layer with a difference of 19.61m2. After comparing the exoskeleton layers post-molt, 

microtubules seem much larger in the deep layer. The area in the deep layer post-molt was ((= 

21.68 m2), while the area of this superficial layer was 91.52 (= 80.45 m2).  

 

Discussion  

DAPI 

After analyzing the results from the images and recording the measurements between DAPI and 

Cytochalasin D, findings suggested that Cytochalasin D increases the relative nuclear size 

slightly more than Nocodazole. If this is true then it may mean that filamentous actin impacts 

nucleus size or that the nucleus is surrounded by F-actin. Actually, this assumption is reasonable. 

While selecting ROIs, in the CytoD_DAPI file nuclei were commonly found right in the center 
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of this cytoskeletal structure and if they did not fall within the center, they were not too far away 

from it. In the past decades, F-actin has been known to be present in the nucleus. Although it is 

known that F-actin is present in the nucleus, recently, researchers have been trying to identify its 

functional role there. The Potential Roles of Actin in The Nucleus, an article published confirmed 

that the functional roles that actin have in nuclear processes are as follows: “nuclear matrix 

association, chromatin remodeling, transcription by RNA polymerase I, II, III, and mRNA 

processing”. In fact, “actin is the key protein necessary for different nuclear processes” despite 

its other roles in the cytoskeleton (Falahzadeh, Banaei-Esfahani, & Shahhoseini, 2015). Thus, 

just knowing this information tells us that while Cytochalasin D drug binds to those “barbed” 

ends of filamentous actin bundles, it could potentially disrupt or impact nuclei as well. 

Filamentous actin bundles and nuclei share a common relationship in the presence of CD (See 

Table 1). Our findings also showed a relationship between DAPI and F-actin in the pre/post 

molting data. We can see a pattern. If there are more F-actin found in the deep layer prior to 

molting, then there will be more DAPI found there as well.  

 

Filamentous actin 

Last year, after collaborating with other research students and associate professor Dr. 

Christensen, we tested the sensitivity of Daphnia magna carapace filamentous actin bundles to 

Cytochalasin D. We suggested that CD pulls actin monomers out of the bundles, formed punctate 

and that F-actin was resistant to CD unless it was already compromised. When CD was exposed 

to these bundles compared to the control group, there was a difference of 80.31 m2. This 

research study suggested that the bundles are larger with CD because the actin is depolymerized, 

more spread out, or placed into the cytosol surrounding the bundles. It may even be that the 
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bundles became disorganized. This number is higher than the control group. Thus, it has to mean 

that the size of F-actin changed. If the structure was slightly compromised (i.e. tear in tissue, 

scratched, etc.) the area should be even higher after exposing it to CD. After examining the 

effects of the molting periods, data suggested that there are more F-actin in the deep exoskeleton 

layer prior to molting (Figure 4). 

 

Microtubules 

In past works, we conducted a study testing the sensitivity of the microtubules in the 

cytoskeleton of Daphnia magna to Nocodazole. Our findings suggested that microtubules were 

resistant to the drug. Similarly, this study suggests that tubulin size is resistant to Noc. Although 

there are differences noticed in the microtubule size, the values are insignificant because of the 

large error bars in the control group. After comparing the post/pre molting effects on tubulin, this 

study suggested that there are more tubulin found in the deep exoskeleton layer post-molt. At 

first, the area of tubulin was larger in the pre molting stage of the superficial layer, but after 

molting, tubulin was lost (Figure 6). This may explain the reason why microtubules are resistant 

to the drug Noc.  

 

Limitations  

The major limitation of this study is time restriction. It took some time to find a method that 

would remove background noise without altering the intensity of the signal that was selected. 

Even after finding this method, we had to find where in the software it was located and figure out 

how to effectively apply it into the study. It was moderately challenging to select F-actin 

structures because arrays were centralized. However, it was much more difficult to select and 
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identify the microtubules arrays because they were long and at times connected to other 

microtubules. Our goal was to select as many signals of the structure as possible but only if they 

are isolated and not attached to other structures. Another limitation to this study was that setting 

a uniform binary threshold for all the images of a single file required more than one attempt and 

measurements could not be recorded without a set threshold. This became an issue because some 

of the images had a binary threshold that could not be adjusted despite all the attempts done. For 

that reason, those images were not included in our data (i.e. F-actin located in the thoracic 

appendages). It would be nice to observe F-actin structures in other parts of this organism, but 

because of time, we were not able to perform anther drug exposure on their thoracic appendages.  

 

Recommendations  

It would be best to break this study into two parts: conduct the drug experiment in one semester 

and interpret the following semester. Keep in mind that data collection and interpretation may 

take a while. Thus, it would be best to have also taken statistics course or college math prior to 

starting a study such as this one. Since actin polymerization is reversible, in the future, testing 

CD washout on disrupted microfilaments will allow a give understanding of its dynamic abilities 

(Schulze, et al., 2013). Another recommendation would be to follow-up with a statistical analysis 

of the data to identify significances in the differences we observed. We just did not have enough 

time.  

 

Figures  

Key: Abbreviations  

Control 1: Used to compare the effects of CD.  

CD: Cytochalasin D  

Control 2: was used for the drug exposure of Noc and Noc+CD. 

Noc: Nocodazole  

Noc+CD: Structures were exposed to combination of both drugs.  
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Figure 1. Data obtained from the both the CytoD_DAPI and NocCD_DAPI file comparing the 

effects of treatments on the nucleus.  

 

 
Figure 2. Data obtained from the CytoD_actin and NocCD_actin file comparing the effects of 

treatments on filamentous actin.  
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Figure 3. Data obtained from the CytoD_tub and NocCD_tub file comparing effects of 

treatments on microtubules.  

 

 
Figure 4. Data obtained from the Post_Pre_Molt_DAPI file showing the effects of molting 

period on the nucleus of D. magna.  
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Figure 5. Data obtained from the Post_Pre_Molt_actin file showing the effects of molting period 

on filamentous actin.  

 

 
Figure 6. Data obtained from the Post_Pre_Molt_tub file showing the effects of molting period 

on microtubules.  
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